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S7-PLCSIM V5.4 including SP8 

Simulation Software 
Readme 

Notes on Installation and Use 
 

These notes should be considered more up-to-date than the information in the S7-
PLCSIM and S7ProSim online help and manuals. 

Read the notes carefully, because they contain information on installing and using 
S7-PLCSIM V5.4 including Service Pack 8. 

 

View the most recent product information online 
The Readme file for S7-PLCSIM V5.4 SP8 is updated as needed and posted as an 
"online Readme" on the Siemens Industry Online Support website. 

Each S7-PLCSIM online Readme contains the contents of the Readme file that 
was included with the product, as well as additional information that became 
available after the product was shipped.  

If you encounter unexpected behavior in S7-PLCSIM, search the Siemens Industry 
Online Support website to see if an online version of the S7-PLCSIM V5.4 SP8 
Readme has been posted.  Search for "S7-PLCSIM V5.4 online Readme" and look 
at the "Known limitations" section of the online Readme to see if there is an entry 
that addresses your problem. 

 

Note when printing the file that the left and right margins are set to a width of 
25 millimeters for A4 portrait format.    

 

 

http://support.automation.siemens.com/
http://support.automation.siemens.com/
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Security information 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it 
is necessary to implement – and continuously maintain – a holistic, state-of-the-art 
industrial security concept. Siemens’ products and solutions only form one element 
of such a concept. 

Customer is responsible to prevent unauthorized access to its plants, systems, 
machines and networks. Systems, machines and components should only be 
connected to the enterprise network or the internet if and to the extent necessary 
and with appropriate security measures (e.g. use of firewalls and network 
segmentation) in place.  

Additionally, Siemens’ guidance on appropriate security measures should be taken 
into account. For more information about industrial security, please visit: 

http://www.siemens.com/industrial-security 

Siemens’ products and solutions undergo continuous development to make them 
more secure. Siemens strongly recommends to apply product updates as soon as 
available and to always use the latest product versions. Use of product versions 
that are no longer supported, and failure to apply latest updates may increase 
customer’s exposure to cyber threats.  

To stay informed about product updates, subscribe to the Siemens Industrial 
Security RSS Feed under: 

https://support.industry.siemens.com 

http://www.siemens.com/industrial-security
https://support.industry.siemens.com/
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1 Installing the software 

S7-PLCSIM V5.4 including SP8 is bundled with the following Siemens software:  

• STEP 7 Professional V13 SP2 

• S7-PLCSIM Standard V14 SP1 

• PCS7 V9 

You can also install S7-PLCSIM V5.4 including SP8 as a standalone application. 
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2 What's new in S7-PLCSIM 

2.1 What's new in S7-PLCSIM V5.4 including SP8 

S7-PLCSIM V5.4 including SP8 offers the following new functions: 

• Support for Microsoft Windows 10 

2.2 Readme notes from previous releases of S7-PLCSIM 
V5.4  

The following paragraphs list all of the new functionality for each release of S7-
PLCSIM V5.4. 

2.2.1 S7-PLCSIM V5.4 including SP7 

S7-PLCSIM V5.4 incl. SP7 offers the following new function: 

• Support for TIA Portal V14 

2.2.2 S7-PLCSIM V5.4 including SP6 

S7-PLCSIM V5.4 incl. SP6 offers the following new functions: 

• Import tags from TIA Portal in .csv, .xls, and .xlsx formats 

• S7ProSim 

• Bug fixes, including: 

 Ability to load a station that includes a CPU with more than 64 
configured communication connections 

 Slider functionality when using double words to change values in 64-bit 
operating systems 

2.2.3 S7-PLCSIM V5.4 including SP5 Update 1 

S7-PLCSIM V5.4 incl. SP5 Update 3 offers the following new functions: 

• Optimization of the displayed interfaces in the "Set PG/PC interface“ selection 
of STEP 7 and S7-PLCSIM in the SIMATIC NET environment 
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2.2.4 S7-PLCSIM V5.4 including SP5 

S7-PLCSIM V5.4 including SP5 offers the following new functions: 

• Support for 64-bit operating systems 

• Support for Chinese (software user interface and documentation) 

2.2.5 S7-PLCSIM V5.4 including SP4 

S7-PLCSIM V5.4 including SP4 offers the following new functions: 

• Use of an optimized MC7 Compiler 

• Support of the Windows 7 Ultimate, Professional and Enterprise operating 
systems. 

2.2.6 S7-PLCSIM V5.4 including SP3 Hotfix 1 

S7-PLCSIM V5.4 including SP3 Hotfix 1 offers the following new functions: 

• Improvement of the process object license management for CFC in the PCS 7 
environment    

• Improved connection establishment to WinCC with standard settings on single 
node systems 

• The last access node selected is restored when a PLC file is opened 

• The status display has been corrected in the SIMATIC Manager dialog 
"Compile and Download Objects"  

• The PROSIM method "connect" can be executed following a restart of a test 
application  

• Improvements in the execution of SFC18, SFC107 and SFC108. 

2.2.7 S7-PLCSIM V5.4 including SP3 

S7-PLCSIM V5.4 including SP3 offers the following new functions: 

• Multiple startability and communication support between the CPUs 

• Optimization of the download scenario 

• Support of an additional PG/PC interface: PC internal (local) 

• Simplified access path 

• Optimization of communication with WinCC and WinCC flexible 

• Display of all CPU access addresses in the status bar. 



© Siemens AG 2017.  All rights reserved. 
A5E42200308-AA, v5.4 SP8, 06/2017 Online Readme Page 8 of 18 

2.2.8 S7-PLCSIM V5.4 including SP2 

S7-PLCSIM V5.4 including SP2 offers the following new functions: 

• S7-PLCSIM V5.4 including SP2 supports loading of configurations with 
"Configuration in Run" objects (CiR objects) during RUN mode.  

2.2.9 S7-PLCSIM V5.4 including SP1 

S7-PLCSIM V5.4 including SP1 offers the following new functions: 

• S7-PLCSIM V5.4 including SP1 supports the group policy "Do not keep history 
of recently opened documents." 

• S7-PLCSIM V5.4 including SP1 enables Windows Vista users to select an 
Ethernet CPU access node and use the ONLINE view of STEP 7 HW Config. 

2.2.10 S7-PLCSIM V5.4  

S7-PLCSIM V5.4 offers the following new functions: 

• S7-PLCSIM V5.4 DP, Industrial Ethernet and PC Internal connection types 
supported in addition to MPI. Formerly, S7-PLCSIM used a default 
connection of MPI, address 2. With S7-PLCSIM V5.4, you can browse STEP 7 
projects and select a networked node for establishing a simulation connection. 
S7-PLCSIM simulates the CPU of the selected node, all nodes that belong to 
that CPU, and the subnet of the selected node. 

• Increased number of blocks supported for simulation.  S7-PLCSIM 
supports a set of OBs, SFBs, and SFCs as described in the electronic manual 
and online help. Of these, some are NOPs; that is, they do not perform any 
operation. With S7-PLCSIM V5.4, the number of blocks that are not NOPs has 
increased. 

. 
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3 Product package 

This update contains a complete version of S7-PLCSIM V5.4 including SP8 
available in the following languages   

• English 

• French 

• German 

• Italian 

• Spanish 

• Chinese 
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4 Software requirements 

Operating systems 
S7-PLCSIM is a 32-bit application that is approved for the following 32- and 64-bit 
operating systems:  

• Windows Server 2008 R2 (Standard edition as workstation computer) 

• Windows Server 2008 R2 SP1 (Standard edition as workstation computer) 

• Windows Server 2012 R2 

• Windows 7 Ultimate SP1 

• Windows 7 Professional SP1 

• Windows 7 Enterprise SP1 

• Windows 8.1 Professional 

• Windows 8.1 Enterprise 

• Windows 10 (64-bit only) 

 
 Note 

 Windows XP mode within Windows 7 is not supported. 

Internet Explorer 
Internet Explorer V6.0 or higher is required for viewing the online help. 
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5 S7-PLCSIM documentation 

You can find extensive information about working with S7-PLCSIM in the online 
help, which you can access from the "Help" menu.  You can access context-
sensitive help by pressing F1 or by clicking the question mark button. 

An S7-PLCSIM manual in electronic form is available on your computer after you 
install S7-PLCSIM. The electronic manual contains the same information as the 
online help. 

Note that the information in this Readme file supersedes information in the 
electronic manual and online help. 
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6 Information on S7-PLCSIM 

6.1 Switching between physical and simulated CPUs 

To avoid confusion between physical and simulated CPUs when using STEP 7 
tools in either SIMATIC Manager or the TIA Portal, you can be in only one mode or 
the other. You can think of this as switching from the "physical world" to the 
"simulated world". Conversely, when physical CPUs are visible, the simulated CPU 
cannot be seen. STEP 7 will prompt you to close any connections to one type of 
CPU before you are able to switch to the other type. For more information, see the 
S7-PLCSIM online help or electronic manual. 

To start simulation mode, use one of these methods: 

• Select the menu command "Options > Simulate Modules" from SIMATIC 
Manager or "Start simulation" from STEP 7 in the TIA Portal. 

• Click the toolbar button for simulation in STEP 7. 

• Start S7-PLCSIM from Windows. 

6.2 Functions of S7-PLCSIM 

You can use S7-PLCSIM to load and test an S7 program without a PLC using the 
standard STEP 7 software and S7-PLCSIM interface. The main benefit is the 
testing of automation functions. The timing is highly different from a physical CPU. 
It is therefore advisable to subsequently test the hardware. Inputs and outputs can 
be easily monitored and changed from the visual interface.  

Not all properties of the S7 CPUs are supported. Some advanced features of 
certain products may therefore lead to error messages with S7-PLCSIM. For a 
more detailed description of the differences, refer to the S7-PLCSIM online help or 
the electronic manual. 

6.3 Shortcut key combinations 

The following shortcut key combinations are available within S7-PLCSIM: 

 

ALT + F1 Allows you to toggle the display of the standard toolbar. 

ALT + F2 Allows you to toggle the display of the Insert toolbar. 

ALT + F3 Allows you to toggle the display of the CPU Mode toolbar. 

ALT + F4 Closes S7-PLCSIM 

ALT + F5 Allows you to toggle the display of the Record/Play toolbar. 
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7 Known limitations 

7.1.1 STEP 7 error message (8402): Online connection to WinAC 
cannot be established 

You might receive this error message when you attempt to download program 
blocks for WinAC using the "PC Systems" option. 

You can ignore this error and set the CPU to RUN within S7-PLCSIM. 

Alternatively, do not select "Start all" or "Start" for the WinAC module. 

7.1.2 Simulation instance limit 

You can run a maximum of 8 CPU simulation instances.  

7.1.3 STEP 7 error message (8301): Working memory too small 

If your program contains one or more blocks with know-how protection, you might 
receive an error message in STEP 7 that your working memory is too small. 

In order for your simulation to run successfully, you must remove know-how 
protection from all blocks and then run your simulation again. 

7.1.4 Incorrect characters in Chinese user interface 

If you will be working with S7-PLCSIM in the Chinese language, you must first 
adjust your Windows Region & Language settings as follows: 

• Save any unsaved work and close all open applications. You will need to 
restart your computer after changing your language settings. 

• Go to the Windows Control Panel and select Region and Language (in 
Windows 7) or Region (in Windows 8) 

• On the Formats tab, change the format to "Chinese (Simplified, PRC)" 

• On the Location tab, change the current location to "China" 

• On the Administrative tab, change the system locale to "Chinese 
(Simplified, PRC)" 

• Restart your computer  

7.1.5 Place CPU in STOP mode to save input and output values 

If you save your project when the CPU is in any state other than "STOP", the inputs 
and outputs are re-initialized and the values they contain are erased.   
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If you want your input and output values to be saved, you must first place the CPU 
in "STOP" mode and then save your project. 

7.1.6 Support for redundant CPU systems 

S7-PLCSIM does not support simulation of redundant CPUs such as the S7-400H 
CPUs. 

7.1.7 Simulation not supported for programming devices with  hyper-
threading enabled 

S7-PLCSIM does not support simulation on a programming device that has hyper-
threading enabled.  Disable hyper-threading and then restart your simulation. 

7.1.8 Unprotect blocks before downloading to S7-PLCSIM 

Program blocks that were encoded with "Block privacy" or programs that include 
encoded program blocks cannot be executed in S7-PLCSIM.  If your program 
contains encoded program blocks, unprotect the blocks before you perform a 
download to S7-PLCSIM. 

7.1.9 Unable to view all values for programs with many active 
elements 

If your program contains a very large number of active elements, the S7-PLCSIM 
execution status might not be able to display all of the input and output values. 

You can view non-displayed elements by using the watch table in the TIA Portal or 
the Variable View Objects in S7-PLCSIM. 

7.1.10 Failsafe data block tag name cannot contain a period "."  

A data error occurs if the tag name for a failsafe DB contains a period. 

To avoid this error, do one of the following: 

• Reference the Failsafe DB with a PLC tag 

• Do not use a Failsafe DB 

7.1.11 Very long download time from the add-on CFC editor  

Be aware that the download time can be up to 15 minutes depending on the size of 
your CFC (Continuous Function Chart) editor program.  Therefore, a very long 
download time does not necessarily indicate that there is anything wrong with your 
program. 
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7.1.12 S7-PLCSIM article (order) number does not match the physical 
CPU article number 

S7-PLCSIM displays a generic article number for your simulated PLC. This article 
number is not the same as the article number for your physical PLC, and the 
number in S7-PLCSIM remains the same the same no matter which physical PLC 
you simulate. 

7.1.13 S7ProSim SavePLC method does not save scan mode 

When you use the S7ProSim method to start S7-PLCSIM with a saved .PLC file, 
note that the scan mode (single step or continuous) might not be restored to the 
value that was present when you saved the file.  Reset the scan mode to continue 
working with your project. 

7.1.14 S7ProSim HotStartWithSavedValues method not functioning 

The S7ProSim method HotStartWithSavedValues does not hot start an S7-400 
PLC.  

When the S7ProSim method SetStartUpSwitch is called to set the startup mode to 
hot start, the Startup Switch Position in S7-PLCSIM does not update to hot start 
and S7-PLCSIM does not go to run. 

7.1.15 S7ProSim write operation failure for S7-300 PLCs 

The S7ProSim write operation methods WriteInputImage and WriteInputPoint 
result in a write operation failure when you select a four-byte (double word) data 
transfer size for S7-300 PLCs. 

To avoid the problem, you can use either a single byte or two-byte (word) transfer 
size for S7-300 PLCs. 

7.1.16 Unsupported communication instructions for S7-300 PLCs 

The following instructions are not supported for simulating communication with S7-
300 PLCs: 

• BSEND/BRCV 

• USEND/URCV 

• TSEND/TRCV 

7.1.17 The ATH  and HTA conversion instructions return incorrect 
values 

The following instructions do not return correct values, and therefore you should 
not rely on the results of these instructions: 
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• ATH - Convert ASCII string to hexadecimal number 

• HTA - Convert hexadecimal number to ASCII string 
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7.1.18 OB 82 does not update the diagnostics buffer 

The process of triggering OB82 errors in S7-PLCSIM does not automatically 
update the diagnostics buffer for the simulated PLC modules. Even though the 
error is triggered on the module level and the module is set to the correct fault, that 
information is not reflected in the diagnostics buffer.  

7.1.19 The CU (Count up) instruction does not function correctly 

The Count up (CU) instruction should only increment the value of a counter on a 
rising edge event.  Instead, this instruction increments the counter value as long as 
power flow is on.  Therefore, you should not rely upon the counter value if you 
have CU instructions in your simulation project. 

7.1.20 The UBLKMOV instruction does not function 

If you want to simulate moving the contents of a memory area, use the BLKMOV 
instruction. The UBLKMOV instruction is not functional.  

7.1.21 No support of hardware configurations of a SIMATIC station or 
SIMATIC PC station with an S5 adapter  

S7-PLCSIM does not support configurations with an S5 adapter. You must remove 
the S5-Adapter or replace it with other I/O and download the modified hardware 
configuration in order to perform simulation.   

7.1.22 S7-PLCSIM V5.4 including SP6 not able to open some simulated 
PLC (*.plc files) from S7-PLCSIM V5.3 or earlier versions 

S7-PLCSIM V5.4 including SP6 uses a different format for simulated PLCs (*.plc 
files) than previous versions. In most cases S7-PLCSIM V5.4 including SP6 can 
open a *.plc file that has been saved in S7-PLCSIM V5.3 or an earlier version. In 
some cases, however, S7-PLCSIM V5.4 including SP6 cannot open a *.PLC file. 

7.1.23 Running S7-PLCSIM and SIMATIC WinAC concurrently 

Do not run S7-PLCSIM and SIMATIC WinAC concurrently on the same computer. 
Doing so can cause WinAC to be affected by modifications to your S7-PLCSIM 
controls. 
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7.1.24 Simulation of a WinAC Controller with S7-PLCSIM 

To simulate a WinAC Controller (WinLC or WinAC Slot), for a STEP 7 project 
download only the block container of your S7 program or only the chart container 
for a PCS7 project. Do not attempt to load the complete station, because then the 
Station Manager would also be loaded, and S7-PLCSIM does not support loading 
the Station Manager. 

7.1.25 Saving S7-PLCSIM layouts and PLC files 

If you save a layout or PLC file in the folder structure of your STEP 7 project, be 
aware of the following: If *.lay files or *.plc files exist in a STEP 7 project folder 
structure, and the project is reorganized from STEP 7 using the File > Save as 
menu command with the "with reorganization" checkbox selected, STEP 7 does 
not copy your *.lay files and *.plc files because they are not native STEP 7 project 
files. You must copy your *.lay files and *.plc files to the new project folder 
manually. 

7.1.26 Downloading a CPU with adjustable interface type (MPI/DP) 

You configure a CPU with a switchable MPI/DP interface in STEP 7 HW Config. If 
you select a PROFIBUS interface but do not connect it to a subnet, an error 
message may occur when this station is downloaded to S7-PLCSIM.  

If the PROFIBUS interface was selected as the active PG/PC interface, when the 
program blocks are downloaded to the default CPU an error message is issued 
stating that they cannot be copied.  When the system data have been downloaded, 
the simulation accepts the configured interfaces. The PROFIBUS is now missing in 
the interfaces as it is not networked. This means that this CPU is not available for 
the further download process. 

Use the drop-down list in the "Standard" toolbar to change the PG/PC interface in 
S7-PLCSIM. 

7.1.27 Displaying S7-300 PIs and PQs is not supported by S7-PLCSIM 

S7-PLCSIM cannot display PIs and PQs for a simulated S7-300 if the PIs and PQs 
are connected over a CP card. The configuration of a CP card of an S7-300 is 
different from that of an S7-400. S7-PLCSIM supports only the CP card 
configuration of an S7-400. 

7.1.28 "Named Connections" not supported by S7-PLCSIM 

S7-PLCSIM does not support the connection type "Named Connections". 

When using S7-PLCSIM with PCS 7, pay attention to the additional information as 
stated in the readme file for PCS 7. Read the section "Using S7-PLCSIM" in the 
PCS 7 readme file. 


	Contents
	Security information
	1 Installing the software
	2 What's new in S7-PLCSIM
	2.1 What's new in S7-PLCSIM V5.4 including SP8
	2.2 Readme notes from previous releases of S7-PLCSIM V5.4
	2.2.1 S7-PLCSIM V5.4 including SP7
	2.2.2 S7-PLCSIM V5.4 including SP6
	2.2.3 S7-PLCSIM V5.4 including SP5 Update 1
	2.2.4 S7-PLCSIM V5.4 including SP5
	2.2.5 S7-PLCSIM V5.4 including SP4
	2.2.6 S7-PLCSIM V5.4 including SP3 Hotfix 1
	2.2.7 S7-PLCSIM V5.4 including SP3
	2.2.8  S7-PLCSIM V5.4 including SP2
	2.2.9 S7-PLCSIM V5.4 including SP1
	2.2.10 S7-PLCSIM V5.4


	3 Product package
	4 Software requirements
	5 S7-PLCSIM documentation
	6 Information on S7-PLCSIM
	6.1 Switching between physical and simulated CPUs
	6.2 Functions of S7-PLCSIM
	6.3 Shortcut key combinations

	7 Known limitations
	7.1.1 STEP 7 error message (8402): Online connection to WinAC cannot be established
	7.1.2 Simulation instance limit
	7.1.3 STEP 7 error message (8301): Working memory too small
	7.1.4 Incorrect characters in Chinese user interface
	7.1.5 Place CPU in STOP mode to save input and output values
	7.1.6 Support for redundant CPU systems
	7.1.7 Simulation not supported for programming devices with  hyper-threading enabled
	7.1.8 Unprotect blocks before downloading to S7-PLCSIM
	7.1.9 Unable to view all values for programs with many active elements
	7.1.10 Failsafe data block tag name cannot contain a period "."
	7.1.11 Very long download time from the add-on CFC editor
	7.1.12 S7-PLCSIM article (order) number does not match the physical CPU article number
	7.1.13 S7ProSim SavePLC method does not save scan mode
	7.1.14 S7ProSim HotStartWithSavedValues method not functioning
	7.1.15 S7ProSim write operation failure for S7-300 PLCs
	7.1.16 Unsupported communication instructions for S7-300 PLCs
	7.1.17 The ATH  and HTA conversion instructions return incorrect values
	7.1.18  OB 82 does not update the diagnostics buffer
	7.1.19 The CU (Count up) instruction does not function correctly
	7.1.20 The UBLKMOV instruction does not function
	7.1.21 No support of hardware configurations of a SIMATIC station or SIMATIC PC station with an S5 adapter
	7.1.22 S7-PLCSIM V5.4 including SP6 not able to open some simulated PLC (*.plc files) from S7-PLCSIM V5.3 or earlier versions
	7.1.23 Running S7-PLCSIM and SIMATIC WinAC concurrently
	7.1.24  Simulation of a WinAC Controller with S7-PLCSIM
	7.1.25 Saving S7-PLCSIM layouts and PLC files
	7.1.26 Downloading a CPU with adjustable interface type (MPI/DP)
	7.1.27 Displaying S7-300 PIs and PQs is not supported by S7-PLCSIM
	7.1.28 "Named Connections" not supported by S7-PLCSIM


